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How to write and sell eBooks 

the  

Simple Way 

 

 

 

 
Writing an eBook has never been simpler with 

the free resources available to you.   

This eBook walks you through the process and 
tells you where to sell them. 
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Introduction 

 

In today’s market, eBooks are hot commodity.  With 
Kindles and IPad’s taking the place of laptops and 

personal computers, you can bet that eBook sales are 
through the roof.   

It isn’t hard at all to write an eBook.  If you have a good 
idea for a book or just want to find out what is selling and 
then explore ideas for writing your own, this eBook is for 

you.  

It will walk you through a step-by-step process for creating 
and then selling your eBook. 

It couldn’t be easier using the techniques in this resource 
and best of all, you can create your own eBook for FREE 
using the resources listed and links provided to you here. 

 

 

 

 

 

 
www.toddlerbitesblog.wordpress.com 

http://www.toddlerbitesblog.wordpress.com/
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Getting Started 
Probably the simplest way to write an eBook is to use Microsoft Word, 
which is already installed on most computers today.  

Simply begin by opening Word and starting a new document.  You will 
continue to scroll down on this one document to create multiple pages. You 
will not create a new page for each page of your book. 

You can add page numbers by hitting the following in the drop down menus 
at the top of your document: 

Insert 

Page Number  (as shown in the picture) 
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You will be given choices about where you want the page numbers to 
appear, such as at the top or the bottom of each page. 

So now you have the backbone of your eBook!  That couldn’t have been 
simpler! 

Once you finish adding all of your content, Word allows you to save the 
document as a PDF.  This is the format that most eBook are saved in and 
is a must if you plan to sell your document for example through Currclick, 
Teacherspayteachers or Kindle Direct Publishing. 

To save your eBook as a PDF, you will simply hit Save As and then hit 
PDF.  You will be asked where you want your eBook to be saved.  As a 
rule, I save mine to my Desktop.  That way, I have ready access to them.   

Now you’re on your way!  You have the backbone of your eBook and know 
how to save it as a PDF.  So, let’s get started adding content! 

 

Another easy tool you can use to write your eBook is Microsoft Office 
PowerPoint. 

PowerPoint is super easy if you plan to add a lot of graphic elements to 
your book.  It allows you to move around the objects and manipulate them 
much easier than Word does.   

I use Microsoft Office PowerPoint 2007, but assume that most are about 
the same.   

Here’s what you do… 

Open PowerPoint.  You will be taken to a new slide show.   

Remove the title and text boxes that automatically are there.   

Design your cover.   
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Click New Slide (under the Home tab) and begin with your first page.  It’s a 
snap!  Just continue adding slides for the number of pages you need.   

One Feature that I like is under the Tab Insert.  It’s the Word Art button.  It 
allows you add a little more pizzazz to your words.  This is great for the  
cover of your eBook. 

Your PowerPoint presentation will automatically be horizontal (landscape).  
To change it to vertical (portrait), you will need to hit the Design tab and 
then Slide Orientation.  You can choose landscape or portrait.   

While you are working on your book, if you want to see what it’s going to 
look like, just hit the View tab and then Slide Show.  You can click through 
to see the entire project and escape if you want to end the show. 

Play around while on the Insert tab.  You can add clip art, pictures, shapes, 
smart art, and charts.  Awesome!  

When you are ready to save your eBook, click Save As and PDF. 
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Finding Free Images 
 

Images like photographs and clip art will be important to your eBook.   

 

Look for public domain images that are free.   

 

My favorite site for photographs is: 

http://www.publicdomainpictures.net/ 

(I also really like the Illustrations section of this site.) 

 

My favorite site for clip art is: 

http://www.wpclipart.com/ 

 

If you are writing a How To eBook, you can take a screen shot of whatever 
you are working on.  You do this by simply hitting the Print Screen button 
found on most keyboards.  The following link has a tutorial that may help 
you understand more about how to take a Screen Shot.  You will notice that 
I have used a screen shot in this eBook in the Getting Started section. 

http://www.wikihow.com/Take-a-Screenshot-in-Microsoft-Windows 

Once you hit the Print Screen button, you simply right click and select 
Paste wherever you want the image to appear in your document. 

 

 

 

http://www.publicdomainpictures.net/
http://www.wpclipart.com/
http://www.wikihow.com/Take-a-Screenshot-in-Microsoft-Windows
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Designing your eBook Cover 
 

The key to a good eBook is having a professional looking cover design.   

Photographs often make the best cover designs.  It is best if you find one 
that is vertical.  You will need to stretch it to fit the entire page.   

Once you have found the image you want to use for your cover, you will 
need to follow the steps below to add it to your Word document. 

Right click the picture you find, and hit Copy Image 

Go back to the first page of your Word document 

Hit Paste 

Click on the image 

Right click, choose Text Wrapping, and then choose Behind Text 

This will cause your picture to go behind the Title and text you create on 
your cover page 

Drag the corners until the image fills up the entire cover page 

You can click on the image and hold down the mouse button to actually 
move it around so that you get it to fit just right on the page 
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Creating the Table of Contents 
 

Creating a professional looking Table of Contents is another important 
element of a well done eBook.  

Look at other eBooks for examples of their Table of Contents. 

You can use the very simple version I have created for this eBook, if you’d 
like. 

If you have added page numbers to your document, it will be a breeze to 
create your Table of Contents.  Adding page numbers was discussed 
previously in the Getting Started section. 

 

Example: 

Introduction……………………………………………..3 

Getting Started………...…………………………….4-5  

Finding free images…………………………………...6 

Designing the Cover…..……………………………....7 

Creating the Table of Contents……………………....8 

What Type of eBook Will Sell Well?…………...…….9 

Where to Sell My Products………………………….10 

Marketing is Key……………………………….…11-12 
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What Type of eBook Will Sell Well? 

 
To find out what type of eBooks are the top sellers, you will simply need to 
observe the market in which you are hoping to sell.  

If you want to sell on Currclick, take a look at their Home Page.  Click on 
each of the current Top 10 (listed in the column at the right).  Be careful to 
observe the kind of eBook and also the price.  Price makes a difference, 
especially if you are selling to the homeschool market. 

www.currclick.com 

 

If you want to sell on Teacherspayteachers, for example, you will need to 
also take a look at their home page.  If you scroll down to the bottom, you 
can see Weekly Top 10.   

http://www.teacherspayteachers.com/ 

 

If you want to sell on Kindle Direct Publshing, you can simply visit 
Amazon and see what the Popular Categories are. 

http://www.amazon.com/Kindle-eBooks/b?ie=UTF8&node=1286228011 

 

 

Note:  The next section talks about how to sell using the companies listed 
on this page. 

 

 

 

 

http://www.currclick.com/
http://www.teacherspayteachers.com/
http://www.amazon.com/Kindle-eBooks/b?ie=UTF8&node=1286228011
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Where to sell my products 
EBay 

The very simplest way to sell your eBook is through EBay! 

Set up an eBay account if you don’t have one already.  Be sure to include 
in the product description that the auction is for an eBook in a PDF format.  
You can email the buyer the eBook file (zipped if it is large), once you 
receive payment.   

Currclick 

If you want your book to reach the homeschool market, then Currclick is the 
way to go! 

You will need to create an account and send in your title for review.  Once 
approved, you can upload other titles.  I have around  59 items currently for 
sale on Currclick.   

Kindle Direct Self Publishing 

If you want to sell products that will be purchased by those with Kindles, 
then you can follow the very simple steps for setting up a free account and 
selling them here. 

https://kdp.amazon.com/self-publishing/signin 

Teachers Pay Teachers 

If you want to sell products to the teaching market (as in school teachers), 
then you may want to check this site out.  Follow the steps for creating an 
account and uploading your products.  The first product must be free, so 
choose wisely.  You want it to be a good product to begin building 
confidence in your items, but you want your best products to earn you a 
profit. 

http://www.teacherspayteachers.com/ 

If you choose to sell through TpT, please be sure to list me as the referral.  Use the following link:  
http://www.teacherspayteachers.com/Signup?ref=ToddlerBites  

http://www.currclick.com/
http://www.currclick.com/index.php?manufacturers_id=322term=toddler%20bites
https://kdp.amazon.com/self-publishing/signin
http://www.teacherspayteachers.com/
http://www.teacherspayteachers.com/Signup?ref=ToddlerBites
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Click here if you would like to see the products I have for sale on TpT: 

http://www.teacherspayteachers.com/Store/Kathy-Hutto 

Teacher’s Notebook 

Teachers’ Notebook is another site which predominantly sells to teachers 
or homeschool parents.  You will need to sign up and pay a fee of $19.95.  
After that, 100% of the money earned from sales of your products goes to 
you!  It is directly deposited into your Paypal account at the time of 
purchase.  No need to wait until the end of a quarter to receive payment.  I 
find this site very, very easy to use.   

http://www.teachersnotebook.com/ 

You can view the products I have for sale on this site by clicking here: 

http://www.teachersnotebook.com/shop/KathyHutto 

Let me know if you have any questions! 

 

 

 

 

 

 

 

 

 

 

 

http://www.teacherspayteachers.com/Store/Kathy-Hutto
http://www.teachersnotebook.com/
http://www.teachersnotebook.com/shop/KathyHutto
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Marketing is Key 
 

Marketing is really the key to any business venture and selling eBooks is 
no exception.   

You can market via Facebook, a Blog, or using the Marketing Tools on any 
of the sites mentioned in the Where to Sell My Products section.   

Here are some tricks I’ve found that seem to boost my sales. 

If selling on EBay, begin with a price of 99 cents.  Don’t do a Buy it Now.  I 
make more money when I start the bidding off small.  It always surprises 
me how much more I make when I sell this way.  Create a template and 
just keep your product on there (one at a time).  When one sells, put 
another one on. 

 

If you are selling on Currclick, create some free products.  As those sell, 
you will increase your customer base.  You can then begin to send email to 
your customers using the very simple tool in the Publisher Menu.  
Marketing couldn’t be easier with Currclick’s Publisher Menu.  I can’t say 
enough great things about it.  I love having the ability to view my own sales 
report and see what products are selling well.  That helps me know what 
direction to take for future products.   You can create discounts and then 
send the notice out to former customers or even those with the product in 
their wish list.  You will see what I mean once you become a publisher on 
this site.  Marketing will be a snap.  But, my number one tip is still to build 
that customer base and then send them emails with discounts for new 
products or even for old products once in a while.  That’s where I see my 
biggest spike in sales.  Homeschoolers like a bargain, so I find that finding 
the right price is also important.  Selling tons of items for 50 cents is better 
than just a few for $10.99, even if it’s worth that much. 
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In a similar fashion, you can use Teacherspayteachers marketing 
resources, though you have to pay for some of these.  You can begin to 
explore these once you have signed up.  The key here, once again, is to 
build your customer base.  That way, when you post a new product, all of 
your customers can receive a notice.  That’s like free advertising!  The first 
product you put on this site has to be free.  Add seasonal free products 
now and then to keep that base growing.  It takes time, but one 
Kindergarten teacher made $700,000 in a year.  It’s important to note that 
she has 12,000 “followers” that are notified when she uploads a new 
product.   

Read more about this teacher here: 
http://mashable.com/2012/05/17/teachers-pay-teachers/ 

  

You can also offer free products on site such as Money Saving Mom.  If 
chosen, your freebie will have exposure beyond your imagination and may 
drive sales your way on other products you offer.   

Again, many authors create blogs of their own.  If you get lots of 
subscribers, you can then begin to alert them to new products you are 
selling.  You really have to work for a while to create good and free content 
on a blog to build that base of followers.  By linking your blog to Facebook 
and Twitter, you can have lots more opportunities to reach customers. 

Another new marketing strategy that is gaining steam very quickly is 
Pinterest.  It took me a little time to warm up to Pinterest, but now I’m a 
believer.  Create a board and then start pinning!  You will be surprised at 
how many re-pins your products will get.  You will begin to see traffic 
building as those pins kind of spider web out and get pinned and re-pinned.  
I’ve personally witnessed an increase in traffic and sales as a result of 
Pinterest.  The sites above have a Pinterest sharing button right beside 
each product, so it’s super easy to use!  Try to find collaborate boards. 

If you know of other places to sell eBook, please let me know.  I’d love 
to add them to this eBook.  I’m sure I’ve only scratched the surface! 

http://mashable.com/2012/05/17/teachers-pay-teachers/
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